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About this manual

Documents
supplied

Typographical
conventions

Complete documentation is provided to help you make optimum
use of the full range of resources offered by your software.

The Online Help provides instant access to context-sensitive
help.

The Administrator’s Guide covers the basic concepts to ensure
you to get the very most from the software. It is designed to
provide effective help for administrators, both first-time and
experienced users.

The User Guide provides an introduction to using the
application. It is designed to get you off to a quick start with the
software by familiarizing you with the basic concepts before
looking at some of the more advanced functions.

The documentation is designed for use in conjunction with the
integrated online help.

This manual distinguishes between different types of
information using the following conventions:
» Terms taken from the interface itself, such as commands,
appear in bold.
» Keys appear in small caps. For example: "Press the sHiFT
key.”
* Numbered lists mean there is a procedure to follow.

* When the conjunction -or- appears next to a paragraph, it
means there is the choice of another procedure for carrying
out a given task.

* When a menu command contains submenus, the menu
name followed by the command to select appear in bold.
Thus, "Go to File > Open” means choose the File menu
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then the Open command.

This symbol highlights warnings and other
important information on how a particular
command or procedure works.

optimizing tasks, speeding up commands, and so

Following this symbol you will find hints and tips for
; on.



CHAPTER 1

Installation

This chapter covers the following topics:
System Requirements

Server Requirements
Workstation Requirements

Software Protection Key

Server Installation

Design/Workstation Installation

Running the Label Print Manager Service

Setting up a User Account
Installing and Uninstalling the Service

Design/Workstation Installation
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System Requirements

Server
Requirements

Workstation
Requirements

When installing this application, you will install two separate
components of the program — the Server component and the
Design/Workstation component.

The Server installation allows you to install the following
components on your server: the Kernel, the label print
engine, the sentinel manager, the sentinel controller and the
User Manager.

The following requirements must be met to ensure
successful installation:

* Windows Server 2012

Windows 2008 R2

Windows 2008 x86/x64

Windows Server 2003 R2

Windows Server 2003 x86/x64 SP2
* 2 GB of RAM minimum
¢ 2 GHz minimum, AMD or Intel Processor
(multiprocessor recommended)
« A hard drive with at least 2 GB free disk space
* A DVD drive
» System must have access to the Internet or have a
dedicated USB port.

Note: The release note contains the latest information on
the software. This information supersedes the information
contained in this manual.

The Design/Workstation installation allows you to install the
Mapper module, the Label designer and the Query
Manager on a workstation.

If you want to create labels on the workstation, you
!-" will have to purchase a separate license for the
label designer to work with this software.
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The following minimum requirements must be met to ensure
successful installation.

¢ Windows Server 2012
Windows 2008 R2
Windows 2008 x86/x64
Windows Server 2003 R2
Windows Server 2003 x86/x64 SP2

Windows 8.1 x86/x64
Windows 8 x86/x64
Windows 7 x86/x64
Windows Vista x86/x64 SP1

« A hard drive with at least 2 GB free disk space

* A DVD drive

¢ A label designer license (software or dongle) if you
intend to create labels on this workstation

Software Protection

Activating the
software key
protection

Your software is protected using a software key (en
electronic code) or a hardware key (a dongle).

The dongle is a small electronic device that you plug into
your PC’s parallel or USB port before launching the
software.

The software key is an electronic code that is requested by
the Activation Wizard when you launch the software for the
first time or as long as you have not activated the software.

You must first install the software and then activate or
connect the protection key to your computer.

Once you have installed the labeling software, the
Activation Wizard will be launched, taking you step-by-
step through the software key protection process.
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To activate the software key
1 In the Activation Wizard, select Activate.

There are up to four possible activation methods: Online
activation, Using a USB key, Using a smartphone and
Using our website.

(Note |

If you have an Internet connection on the computer
where the software is installed, online activation is
automatically selected.

Online activation

Some enterprise networks are protected by a proxy server.
In this case, there is a Settings button to setup your proxy
settings to connect to the Internet.

1 Enter the Serial number and the password provided with
the product and click Next.

2 Depending on your connectivity, Connection Test step is
displayed. This allows you to setup your connection. Click
Next.

3 Enter or edit your information in the User Registration
form. Click Next.

4 Click Finish.

(Note |

If you do not have an Internet connection on the
computer where the software is installed but you have
access to another computer with an Internet
connection, you can activate the product using a USB
key.

Using a USB key

1. Enter the Serial number and the password provided
with the product and click Next.
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2. Select Using a USB key.

3. Select the media to be used for activation (USB key or
external hard disk or network drives) and click Next. Files
for activation will be copied onto the selected media.

4. USB devices only: Unplug the removable media and plug
it into the computer connected to Internet.

5. On the computer connected to the Internet, double-click
USBWizard.exe (which can be found on the root of the
media). This will start the Activation wizard.

6. Select the license(s) to activate and click Next.

7. Enter or edit your information in the User Registration
form. Click Next.

A message will inform you that the activation information
for the selected license(s) has been successfully
retrieved.

8. USB devices only: Unplug the removable media from
this computer and plug it back into the computer where
the software is installed.

9. On the computer where the software is installed, double-
click USBWizard.exe again (the file can be found on the
root of the media).

The wizard will display the license that can be activated on
the computer where the software is installed.

10. Click Next.11.
Click Finish.
If any problems were encountered, a message will inform

you that the activation has failed and an error will be
displayed.

[ Note
If you do not have access to a computer with an Internet
connection, you can activate the product using a
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smartphone.

Using a smartphone

A barcode scanner application is required to read the
barcode which allows you to activate your software using a
smartphone. You can download this from your application
store / market. This activation mode uses an Internet
connection on your smartphone.

1 Enter the Serial number and Password provided with the
software and click Next.

2 Select Using a smartphone.

3 Input your information in the User Registration form. Click
on Next.

4 A barcode appears. Move the cursor over the barcode to
zoom in.

5 Open your barcode scanner application on
your smartphone.

6 Scan the barcode with your smartphone.

7 Click Continue or open the browser on the phone.

8 The Software Activation website is displayed. This allows
you to register and activate your software. All fields must
be filled in.

9 Click Submit.

The Validation code and Installation code are
displayed at the bottom of the Software Activation website

page. Please scroll down if necessary.

10 Enter the Validation code and Installation code in the
wizard (using uppercase characters).

11 Click Next.

12 Click Finish.
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Using our website

1 Enter the Serial number and Password provided with the
software and click Next.

2 Select Using our website.

3 The link provided on this screen (http://www.teklynx.eu/
nsp/) can be reached from a different computer with Internet
access. You or someone else with an Internet connection
can connect to our website to complete the activation. The
Serial Number and Password (provided with the product)
and the User Code (displayed in the wizard) will be required
in order to use this service.

4 Enter the license user's information in the User
Registration form displayed on our website. Click Next.

5 Click Submit.
6 The Validation code and Installation code are displayed
on our website. Enter these in the wizard (using uppercase

characters) and click Next.

7 Click Finish.

Server Installation

Server installation allows you to install on your server the
various modules used to build an automatic data exchange
solution between your applications and devices and our
labelling products.

Step 1 Place the DVD in your server’s DVD drive.

Step 2 The installation program should launch
automatically.

If it does not, go to Windows explorer and expand the
letter of the DVD drive. Double click CDSETUP.EXE
(for example, D:\cdsetup.exe).
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Step 3 In the tree structure containing the various
installation options, select the server option of the
product you’ve purchased.

Step 4 Follow the on-screen instructions to complete
the installation process.
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Design/Workstation Installation

Design/workstation installation installs the Mapper module,
which is used for defining how data exchange will be done
between your application and the Label Print server. In the
Design/Workstation installation of the product you have
purchased, the Query Manager application will also be
available for installation. This installation allows you to set
up queries over a database system that can be executed by
the sentinel server during a data exchange between your
datafiles and your labeling software.

Step 1 Place the DVD in your workstation’s DVD drive.

Step 2 The installation program should launch
automatically.

If it does not, go to Windows explorer and expand the
letter of the DVD drive. Double click CDSETUP.EXE
(e.g. D:\cdsetup.exe).

Step 3 In the tree structure containing the various
installation options, select Design/workstation and
then the required components.

Step 4 Follow the on-screen instructions to complete
the installation process.

If you want to design a label and to use the label
design option available with the Mapper, you will
have to purchase a separate license for the label
designer to work with this software.
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Running the Label Print Manager Service

The

application runs as a service on the host workstation.

This means it will launch automatically when the
workstation is started.

@

Step 1 To define the startup options for the Label Print
Manager Service:

For Windows versions older than Windows 8: Select
Start > Settings > Control panel Services and select
Label Print Manager.

For Windows 8 and 8.1 users: Access the search tool.
To access and use the search tool, open the Charms
menu by pressing Win [Windows key] + C on your
keyboard or by swiping in the top-right or bottom-right
corner. Once the Charms menu pops open, click/tap
the Search button and enter Label Print Manager.

Step 2 Select a start method.
Choose either:

* Automatic: The service launches when the
workstation is started.

* Manual: The service must be activated manually.
You will therefore need to open a Windows work
session and then launch the service in Control panel
Services. Select Label Print Manager from the list of
services and then click Start.

The above start methods launch the service and
the sentinels at the same time. All available
sentinels are thus launched when the service is
started.

Whatever the start method is, you can control the service
activity by launching the Kernel from the application
programs group.

If the service is stopped, a start request is sent to the
system. When the service is started, the application
management icon displays in the system tray. Using this
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Setting up a
user account

icon, you can start or stop the service and the different
application modules.

Unlike the start method using the Windows

!‘ Control panel services, the start method from the
Kernel does not launch sentinels (which would
instead be launched from the Controller).

The application must be able to access shared network
folders and print on network printers. You must therefore
select a user account to which these rights have been
assigned.

Step 1 Select a user account, then enter the
password.

The selected account must be declared in the
._F" local administrator group of the workstation.

running, simply open a work session and then
launch the application via the program group
defined during installation. The default name of the
group is the same as that of the application.

Q To view sentinel status while the service is
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Installing/
Uninstalling the
Label Print
Manager
Service

Once the application is installed, you can always uninstall
the Label Print Manager service and reinstall it later.

For Windows versions older than Windows 8:

Step 1 To install the Label Print Manager service,
select Start > Run [name of application installation
folder] \ TKXKernel.exe -i.

Step 2 To uninstall the Label Print Manager service,

select Start > Run [name of application installation
folder] \ TKXKernel.exe -u.

For Windows 8 and 8.1 users:

To install the Label Print Manager service

Access the search tool. To access and use the search
tool, open the Charms menu by pressing Win
[Windows key] + C on your keyboard or by swiping in
the top-right or bottom-right corner. Once the Charms
menu pops open, click/tap the Search button and
enter TKXKernel.exe -i.

To uninstall the Label Print Manager service

Access the search tool. To access and use the search
tool, open the Charms menu by pressing Win
[Windows key] + C on your keyboard or by swiping in
the top-right or bottom-right corner. Once the Charms
menu pops open, click/tap the Search button and
enter TKXKernel.exe -u.



CHAPTER 2

Introduction

This chapter covers the following topics:
Definition of Terms
Basic Concepts

How it Works
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This application is a server application dedicated to the
data exchange between your application and our products.
It allows you to automatically print barcode labels created
with your labeling software by simply exchanging
information between your ERP/WMS system and the
sentinels server.

Definition of terms

The application involves a number of specific concepts
which are explained below.

Sentinels server: PC running supported Microsoft
Windows platform on which the application is installed.

Input data: The data generated by your system. They are
received by the sentinels server via a communication
channel.

Bearer channel: Once launched, each sentinel “listens” to
a specific bearer channel.

Sentinel printer: The printer created by the application on
the print server which users can then designate as the
output printer in their applications.

Sentinel: The procedure used for analyzing and
processing data generated by your application.

Mapfile: Describes the method the sentinel will use for
analyzing input data.

Plug-in: The process module executes a specific task
during a sentinel process.

There are four types of plug-ins:
* The Input plug-in listens to a data bearer channel
supplying a sentinel.
» The Process plug-in processes information retrieved
from input data.
* The Report plug-in informs users and updates a
report about sentinel process.
* The Output plug-in backs up or transmits input data to
a file
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Basic concepts

How it works

Plug-ins list available in your application depends
' on the product used.
&

The application monitors data communication channels
connected with your system. As soon as a channel receives
data, the application analyzes the incoming data and
processes them through one or more process plug-ins. The
communication channel has to be chosen according to your
application and the input plug-in you have at your disposal.

The application runs as a Windows background task. This
application is considered a service by the system and can
thus be launched with the system. Sentinels are used to
define analysis and printing tasks. Once launched each
sentinel monitors the bearer channel for which it has been
configured. When data coming from your system are
received on the bearer channel, the analysis and process
activity begin.

Input data is filtered by the map file of the sentinel. As for
each printing request, input data information is sent to the
different process plug-ins configured for the sentinel.

At the end of the process, input data is sent to the output
plug-in in order to be transferred or saved.

During each step of the process and after sentinel
validation, information concerning the sentinel process is
sent to the report plug-in.
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F|Ie
Capture

Prlnt
Capture

e

TCP/IP

Figure 1 Input and Process Plug-in Flow



CHAPTER 3

The Application Modules

This chapter covers the following topics:

The Application Modules
* Web Manager
* User Manager
* The Kernel
* Sentinel Manager
* Sentinel Controller
* Mapper
¢ Query Manager
* Plug-ins

Brief Overview: The major steps from creating to run-
ning the sentinels.

* On Your Workstation

* On the Server
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The application modules can be put into three categories
depending on their usage in the software.

The first category comprises the kernel module, the
controller, the sentinel manager, the user manager and the
Web Manager application. All of them are used to create,
configure and run sentinels processes. They all come with
application’s server installation.

The second category comes included with the workstation
installation. It comprises two applications: The Mapper and
the Query Manager. Both are used to preset the
configuration files for the defined sentinels by the server.

The third category is the Plug-in modules. Plug-ins are thin
application modules dedicated to accomplish one unique
task. They perform all the actions a sentinel is configured to
do. They are installed by the both the server and designer
installations.

The application modules

Web Manager

User Manager

Kernel

The Web Manager acts as an interface to the sentinels
server over the internet/intranet. It allows the user to
interact with any sentinels server, regardless of its location,
via their internet browser by typing in the web application’s
address in the browser’s address line.

The User Manager secures the internet connections to the
sentinels server, by allowing an administrator to set
permissions for application users.

The Kernel is the core application that manages all other
tasks, including launching sentinels and monitoring sentinel
activity. If the Kernel is closed, all sentinels will be disabled.

The Kernel operates as a background task and can be
configured to launch automatically when your workstation is
started up. It is therefore not necessary to open a Windows
work session for the application to run.

Once launched from the application program group, the
Kernel module appears as an icon on the Windows taskbar.
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You can access Sentinel Manager and Sentinel Controller
via the Kernel menu.

Step 1 Right-click on the Kernel icon .gl.'-"i .
Step 2 Choose the required module in the menu.

Sentinel Sentinel Manager is launched via the Kernel menu and
Manager allows you to create, configure, and manage the sentinels
that will analyze your input data.

Sentinel Sentinel Controller is launched via the Kernel menu or

Controller Sentinel Manager. It allows you to view sentinel status,
enable or disable individual sentinels and display the error
logfiles.

Mapper The Mapper allows you to create and configure the

mapfiles which will analyze your input data. A mapfile
describes the structure of the input data for analysis and
assigns the mapped data to the corresponding variables in
the initial document. Mapper is accessed via the application
program group or Sentinel Manager.

Mapper features an integrated wizard to guide you through
the process of creating and configuring mapfiles. See the
User Guide for a full description of the module and
examples of how to create mapfiles.

Query Manager This application module lets you define queries over
different database systems and lets you group them into
tasks that can later be invoked by a sentinel through the
use of the database process plug-in.

Brief Overview: The major steps from creating to
running the sentinels

Here is a general overview of the main steps to take in
order to configure a sentinel that will receive text files into a
specific folder and will print the corresponding barcode
label.
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On your Use the Mapper module to:
workstation
* Define the structure of the files that will be used for
label printing (known as “mapfiles”).
* Design the labels directly in your labeling software.
* Test the map.

On the server Use Sentinel Manager to:

* Create sentinels that will analyze your input data from
the text files.

« Define their properties and the properties of the
plug-ins associated with them.

* Enable sentinels for starting.

Use Sentinel Controller to:

* Enable individual sentinels.
* Launch printing.
* Monitor printing.

-0r-

Use the Web Manager, via the web, to create, define,
enable and launch sentinels. The Web Manager acts as an
online Sentinel Manager and Sentinel Controller all rolled
into one. However, monitoring via a real-time logging cannot
be done online.



CHAPTER 4

User Manager

This chapter covers the following topics:
Launching the User Manager
Adding New Users
Defining or Changing User Rights

Changing a Password
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Setting Permissions

In order to secure the internet connections to the sentinels
server, the User Manager will allow an administrator to set
permissions for application users. The different types of
permissions include:

¢ Administrate: Allows the user to launch the Security
Management module and change the rights of other
users.

* Manage: Allows the user to add, remove or configure
sentinels as well as enable/disable sentinels.

* Operate: Allows users to start/stop sentinels.
* Control: Allows the user to view sentinel activity via the

Web Manager without any right to alter the settings or
activity of the sentinels in any way.

Launching the User Manager

The User Manager can be launched from the shortcut
available in the application program group.

igix

User Help
User Administrate Manage Operate Contral

Fpdmn) e |

Figure 1 User Manager window

Adding new users
Once you've launched the User Manager:
Step 1 Go to User and select Add.

A box will pop-up prompting you to enter a user name.
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User name:

fi
Ok I Cancel |

Figure 2 Create User window

Step 2 Click OK.

You will see that the user has been added to the list
but no permissions have been defined.

Defining or changing user rights
Determine the user whose rights you want to set or change.
Step 1 Go to User.

Step 2 Select the highest level or rights you want to
assign the user.

If like to give a user the ability to start/stop sentinels, select
Operate from the list of available permissions. You will
notice that Yes appears for each right given to the user. In

this case, you would see Yes under Operate and Control,
but not under Manage and Administrate.

Changing a password

The User Manager also allows you to change the password
assigned to users.

Step 1 Go to User.
Step 2 Select Change password.
Step 3 Enter the old password.

Step 4 Enter a new password.
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CHAPTER S

Web Manager

This chapter covers the following topics:
User Interface
Permissions
Using the Web Manager

« Creating or Modifying an Existing Sentinel
* Sending Out the Sentinels
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The Web Manager is the user interface for the sentinels
server. It can be accessed by any user, from any browser,
anywhere in the world, as long as that user has been given
permission, a user name, and a password by the
administrator.

The Web Manager can be installed on a different server
from the one sentinels server runs on. Installing them on
separate servers ensures that:

* The deployment and maintenance of the Web Manager
application is easier and runs more smoothly since a
single web server can administrate multiple sentinels
server on the network.

* They are each running at full power by giving the Web
Manager and the sentinels server their own server.
Depending on the number of opened sessions, the Web
Manager can consume a lot of processor time which
may hinder the power of sentinels server.

* The Web Manager can run on an already existing web
server.
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User Interface

Typing in the Web Manager’s URL in the browser will
display the Data Exchange Server’s login page.

2 WebMA - Microsoft Internet Explorer.

SENTINEL

Login

Figure 1 Web Manager Login screen

This page is the gateway to the Sentinel Control and
Configuration page.

Step 1 Enter a valid user name and password (these
have been configured and given to you by an
administrator).

Step 2 Select the name of the sentinels server you
want to work with.

Step 3 Click Connect.

The selection of the server is done from a combo box. This
combo box is linked to a file that the administrator has
configured which lists the available sentinels server names
and the associated TCP/IP port to be used (if no port is
specified, a default port will be used instead).

If your connection is successful, a page listing all the
sentinels defined on the sentinels server will be displayed.
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Permissions

If not, please try again, or contact your administrator to
verify that your user name and password are correct.

A WebMA - Microsoft Internet Explorer EExX

SENTINEL

mardi 6 mars 2012 11:57:42

Print rurning

Preview running

Conteate
ibomk
ony
objea

Figure 2 Sentinel list window

The administrator can set up your account to give you
some or all of the possible permissions.

Depending on the permissions you have been given, your
account may allow you to:

 Create a new sentinel

 Delete one or more sentinels

* Edit or modify the settings of a particular sentinel
¢ Enable one or more sentinels

¢ Disable one or more sentinels

 Start one or more sentinels

» Stop one or more sentinels

* Refresh the Web Manager
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The fol

lowing icons are to be used for the above mentioned

functions:

' Create a new sentinel

Delete one or more sentinels

Edit or modify the settings of a particular sentinel
Enable one or more sentinels

Disable one or more sentinels

Start one or more sentinels

Stop one or more sentinels

.2 | Refresh the Web Manager

The Web Manager’s refresh button must be used
to refresh the screen and to show up-to-date
sentinel information and status. It is advisable
NOT to use the browser’s refresh button as it will
only perform your last command/request again
and may not refresh the data. A time and date
stamp is available at the top of the screen to
inform the user when the last update took place.
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Using the Web Manager

Creating or
Modifying an
Existing
Sentinel

Once the user has successfully logged in, a list of available
sentinels will be displayed. Just like in the Sentinel
Manager, the group name, the sentinel name, its state and
whether the sentinel has been enabled will be displayed on
the screen.

One or multiple sentinels can be selected by clicking in the
check box - a check mark will appear to show that it has
been selected and the selected sentinel(s) will change to
the color orange. Clicking in a group box will automatically
select all the sentinels belonging to that group. Disabling a
sentinel will change the ‘enable’ box color to red. Starting
the sentinel will change the ‘state’ box to green. In an
unselected, enabled and stopped state, the sentinel
remains in the default color - white.

The icons below the list can be used to perform a number
of tasks as long as the user’s account has the permission
to do so.

Clicking the Create new sentinel icon or selecting a

sentinel and clicking the Edit/Modify sentinel @ icon

will bring up the Sentinel Configuration screen. Here, the
user can select the sentinel’s input/output/process/report
plug-ins. Clicking on the oil can icon will take

-

you to the Plug-in Settings screen.



Web Manager Chapter 5 - 31

2 WebMA - Microsoft Internet Explorer.

n r

@® File capture

© Database watch

© TCP/IP port listening
© Print capture

O web Server

Process
CODESOFT Printing
[ patabase

[ web Service Client

Output:
[ Transfer

Report.
Log File
0 E-mail
[ TCP/IP port listening

Figure 3 Plug-in settings screen

Only one input plug-in can be selected for each sentinel,
however, you can select as many output, process or report
plug-ins as you would like.

For more information on the different plug-ins and
their settings, please see Appendix A - Plug-ins.

Once the configuration has been completed, click m to
return to your list of sentinels.

Sending Outthe To send out the sentinels, you must:

Sentinels
Step 1 Select the sentinel(s) you want to activate by

clicking in the appropriate check box.

Step 2 Click E to enable the selected sentinel.
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Step 3 Click Q to start the selected sentinel(s). The

screen should automatically refresh to show the state
of the sentinel(s) as “running.”

Clicking o will disable the selected sentinel(s), making it

impossible to run. Clicking B | il stop the selected
sentinel(s). To verify that the sentinel has indeed stopped,

=,
click %4 | to refresh the screen and see the latest update.

Stopping sentinels may take a few seconds. The
% more sentinels you stop at one time, the longer it
may take. If you have clicked the Refresh button
and do not see the correct state of the sentinels
displayed, please wait a few moments and refresh

again.




CHAPTER 6

Sentinels

This chapter covers the following topics:
What Are Sentinels?

How Do Sentinels Work?
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What are sentinels and how do they work?

A sentinel is simply a group of settings the application uses
to intercept and process the information coming from your
application and devices.

Once activated, each sentinel acts on your system as an
analyzing and processing service giving you the ability to
exchange data between your application and TEKLYNX
products in order to build a complete automatic ID solution.

Each sentinel must specify:
* A bearer channel on which your printing requests will
be received.
* A method for data analysis given by the map file
selection associated with a sentinel.
* One or several types of processes to be implemented
for each information block identified in the input data
according to the sentinel map file.
* One or several types of logs to be generated when a
specific event is detected during analysis or during input
data process.
* One or several types of backup input data once they
have been treated.

A sentinel must belong to a group. Each group can contain
as many sentinels as your organization requires. The
organization of sentinels within a given group is just
performed for organizational purposes.

channels, type of process, type of log generated,
and type of backup will vary depending on the
labeling software version you are using and the
plug-ins available for that product version.

Q The choice of possibilities for communication

How do sentinels work?

After you have selected an input plug-in and one or more
output plug-ins for your sentinel, when the sentinel is
activated, the input plug-in is also activated and it monitors
its bearer channel. When information is received on its
channel, the plug-in sends input data to the core
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application. Data are then analyzed according to the map
file associated to the sentinel.

For each information block detected, the core application
sends data to the different plug-ins associated with the
sentinel. Data are treated according to the order sets up in
the sentinel. Once data are treated, the analysis goes on
towards the next blocks. The same process is repeated
until all the data have been processed.

The core application sends data received by the input plug-
in to the different output plug-ins. These plug-ins are
configured to implement the different backup processes.

For each step of the process, the activity parameters of the
sentinel are provided to the selected log plug-ins, by the
core application.

The diagram below shows the workflow.

Input data e

Qutput data (f 1?1

Note: Some sample files for the this applications are
available in the document folder of the application
(C:\Users\Public\Public Documents or C:\Document And
Settings\All Users\Documents)
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CHAPTER 7

Sentinel Manager

This chapter covers the following topics:
Launching the Program

Description of the Main Window
* Menu Bar
* Workspace
* The Toolbar
* Selecting a Tool

Interface Settings
* Changing Display Options
* Changing the Interface Language
 Adjusting Column Width
* Adding a Sentinel
* Defining the Properties of a Sentinel

Managing Sentinels
* Duplicating a Sentinel
* Deleting a Sentinel
* Activating a Sentinel
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Launching the program

Once launched from the application program group, the
Kernel module appears as an icon on the Windows taskbar.

To access Sentinel Manager:
Sp.
Step 1 Right-click on the Kernel application icon ;l.’“ .

Step 2 Choose Sentinel Manager in the menu.

The main Sentinel Manager window appears.

& Manager

L-[0x]

Sertingl Wiew Tools Help

T
0% WE® 2 [y -
Group | Narme | Enable | Stete |
testing sentinell u] B Deactiva.
test sentinel 2 u] . Deactiva.
New New m} A Underca..

Propeties

Cormments

Input Wieh Server
Process ‘el Service Client
Qutput

Repart

Stop onerrars. No

Figure 1 Sentinel Manager window

Description of the main window

This section presents a general overview of the main

elements that make up the interface as they appear in the
main window at the beginning of a work session.

Menu Bar The menu bar comprises four drop-down menus: Sentinel,
View, Tools, and Help.
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Workspace

The Toolbar

keyboard shortcuts. Press ALT plus the key
corresponding to the letter underlined in the menu
name, then the key corresponding to the letter

Q To access commands using the keyboard, use the
underlined in the command name.

The workspace occupies the central part of the main
window. The list of sentinels is displayed in this area as a
table.

These tools allow you to execute routine tasks more quickly
than using the menus.

O =- ME & 2 [~oows -

To select a tool, click the button corresponding to the tool.

Interface settings

Changing
display options

Changing the
interface
language

Adjusting

column width

Adding a
sentinel

You can display the interface in English or French. You can
also modify column widths and select a display filter.

Step 1 Choose Tools > Options.

Step 2 Select the required language in the language
zone.

A checkmark shows which language is selected.

Place the cursor over the column’s right-hand border in the
table header and drag it to the left or right to obtain the
required width.

Choose Sentinel > New.

The new sentinel appears in the table. lts status is defined
as "under construction”.
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Defining the

properties of a

sentinel

The General tab allows you to assign a name to the new
sentinel, add any comments and associate it with a group
and a map file.

Step 1 Enter a name in the zone Name.

Step 2 In the zone Group, select a group or type a
group name. If needed, type comments.

Step 3 Select the map file defining the structure of
your data file.

Step 4 Select the Stop on errors check box if you
want a sentinel process to be stopped when an error
occurs.

The others tabs allow you to define which plug-in you want
to run for the Input, the Output, the Process and the Report.

If you want more information about the plug-ins, please
refer to Appendix A: Plug-ins at the end of this manual.
You will also find information about the plug-in selected in
each tab of the Sentinel Properties dialog box.

Managing sentinels

Duplicating a
sentinel

Deleting a
sentinel

Sentinel Manager allows you to carry out a number of
operations, including duplicating an existing sentinel.

Step 1 Select the sentinel.
Step 2 Right-click the sentinel.
Step 3 Choose Duplicate in the context menu.

The duplicated sentinel appears in the list with the same
name followed by copy no. x.

Sentinel Manager also allows you to delete sentinels.
Step 1 Select the sentinel.

Step 2 Right-click the sentinel.
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Activating a
sentinel

Step 3 Choose Delete in the context menu.

In order to activate a sentinel (from the service or from the
Sentinel Controller), you must first enable it in the Sentinel
Manager.

If you want a sentinel to be processed in the Sentinel
Controller, it should first be enabled in the Manager.

Step 1 Select the sentinel.
Step 2 Check or un check the box in the Enable
column. If you check this box, the sentinel will appear

in the Controller.

Step 3 You can launch the Sentinel Controller from the

Tools menu of the Manager or click “ .

For more information, please see Sentinel Controller
chapter.
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CHAPTER 8

Sentinel Controller

This chapter covers the following topics:

How Sentinel Controller Works
Launching the Program

Description of the Main Window
* Menu Bar
* The Sentinel List
* The Toolbar
* Selecting a Tool
¢ Information Panel
¢ The Status Bar

Interface Settings
* Changing Display Options
* Adjusting Column Width
* Displaying a Specific Group
* Modifying the Display Order
* Displaying Sentinel Properties
* Activating one or more Sentinels
» Deactivating one or more Sentinels

Sentinel Status
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Task Management
* Viewing Current Tasks
* Cancelling a Task

Error Management
» Structure of the Error Logfile
* Error Messages
* Deleting an Error Lodfile
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How Sentinel Controller works

Sentinel Controller allows you to view sentinel status,

enable/disable individual sentinels and display the printing
and error logdfiles.

Sentinels are created and set up using Sentinel Manager.
When you modify the properties of a sentinel, the changes
are automatically updated in Sentinel Controller. Once
enabled in Sentinel Controller, the sentinel is assigned
Activated status in Sentinel Manager and cannot be
modified while running.

Launching the program

You can launch Sentinel Controller via the Kernel menu or
Sentinel Manager.

To access Sentinel Controller:

»

Step 1 Right-click the Kernel icon =4~

Step 2 Choose Sentinel Controller in the context

menu.
liliController N [=] B3
Sentinel  Edit  View Help
@ B | #® 2 [~racwe: -
| Group | Name | stete | Pass | Rl |
testing sentinell

sentinel 2

Jobs | Log Properties £
29/06/2005] [10:48:00] Database : Mo task defined =
29/06,2005] [10:48:00] File capture : The directory does not exist
29/06,2005] [10:48:00] File capture : Unable to ster the sentinel
29/06/2005] [10:48:01] Stopped
11 ]
11 ]
][ ]
][ ]

29/06/2005] [10:48:20] Database : Mo task defined

29/06,/2005] File capture : The directory does not exist.
File capture : Unable to start the sentinel
Stopped

10:48:20
10:45:20
10:45:20

29/06/2005
29/06/2005
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Description of the main window

This section presents a general overview of the main
elements that make up the Sentinel Controller interface, as
they appear in the main window at the beginning of a work
session. The main window is divided into two areas:

* The sentinel list
* The information panel

Menu bar The menu bar comprises four drop-down menus: Sentinel,
Edit, View, and Help.

keyboard shortcuts. Press ALT plus the key
corresponding to the letter underlined in the menu
name, then the key corresponding to the letter
underlined in the command name.

@ To access commands using the keyboard, use the

The Sentinel list  The sentinel list occupies the central part of the main
window and is displayed as a table.

The toolbar These tools allow you to execute routine tasks more quickly
than using the menus.

Selecting a tool  Click on the button corresponding to the tool.

@ | | % @ IAIIgrDups j

Information The information panel, located in the lower part of the

panel window, comprises three tabs which display information on
pending tasks and the printing/error lodfiles respectively.
You can show or hide the information panel using the
command View Information or the Information tool

button ’E .
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list and the information panel by dragging it with

You can move the border separating the sentinel
; the cursor.

Interface settings

Changing You can modify column widths and/or select a display filter.
display options

Adjusting Place the cursor over the column’s right-hand border in the
column width table header and drag it to the left or right to obtain the
required width.

Displaying a You can display sentinels belonging to a particular group.
specific group Choose View > Group and then select the required group
of sentinels.
- or -

Select the option directly from the toolbar.

Modifying the Click on the header of the column by which you wish to sort
display order the sentinels.

Displaying You can display the properties of a sentinel.

sentinel

properties Step 1 Select the sentinel.

Step 2 Choose View Information.

Step 3 Click the Properties tab.

Jobs Log Properties | fif

Comments

tap S2map
Input File capture
Process Database
Output

Report

Stop anerrors| No
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Activating one
or more
sentinels

Deactivating
one or more
sentinels

Step 1 Select the required sentinel(s) using the mouse
or the Select all and Invert selection commands.

Step 2 Click the @' button to activate the selection.
- or -
Choose Sentinel > Activate.

Step 1 Select the required sentinel(s) using the mouse
or the Select all and Invert selection commands.

step 2 Click the Il button to deactivate the
selection.

- or -
Choose Sentinel > Deactivate.
Unlike sentinels are activated by the service, all

sentinels launched manually will stop processing
when the application is closed.

Sentinel status

© B

A symbol appears next to each sentinel in the list to
indicate its status.

This symbol indicates the sentinel is deactivated.

This symbol indicates the sentinel is about to begin
analysis.

This symbol indicates the sentinel is under
construction.

This symbol indicates the sentinel is activating.

This symbol indicates the sentinel is processing a datafile.
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Task

The Information panel allows you to monitor the progress of

management

current tasks.

Joks Log Properies

File {4)

Size | Created

Expelah
ExpeSubLab
Expecition.td
Expecition.map

140Kb  09:15:58
10Kb 09:35:54
4Kb 171820
2K 172118

Viewing current  Activate the Information panel and click the Jobs tab.

tasks

Error Management

When Sentinel Controller detects an error during datafile
analysis, it updates the relevant error lodfile located in the
application LOGFILES folder. The filename of the logfile will
be that of the sentinel. The logfile describes the nature of
the error so you can rectify it if necessary.

To view the error lodfile for the selected sentinel, display
the Information panel, and then click the Log tab.

The Error column and the sentinel symbols indicate any
errors encountered during datafile analysis.

To reset the error counter, right-click on the sentinel and
then choose Reset Error Counter in the context menu.

Structure of the
error logfile

This file allows you to monitor file processing status.
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Error messages

Deleting an
error logfile

Error messages inform you of the nature and source of any
errors so you can rectify them. Error messages include the
error number, the date and the time, the name of the file
concerned, and the error message.

rrrrrrrrrrrrrr

Jobs Log Froperties  frriiiriiiiiis

[29/06/2005] [10:48:00] Database : Motask defined.

[29/06/2005] [10:48:00] File capture : The directory does not exist.
[29/06/2005][10:48:00] File capture : Unable to start the sentinel
[29/06/2005] [10:48:01] Stopped

[24/06/2005] [10:48:20] Database : Motask defined.

[29/06/2005] [10:48:20] File capture : The directary does not exist.
[29/06/2005] [10:48:20] File capture : Unable to startthe sentinel
[£9/06/2005] [10:48:20] Stopped

You can delete error logfiles using the Information panel.

Step 1 Select the sentinel to which the error lodfile is
associated.

Step 2 Click on the Information panel Log tab then press
CTRL + DEL.

Deleting an error logfile will permanently remove
._f': the .log file.
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Plug-ins

This appendix covers:

Information about the configuration and selection of the
different plug-ins:

Input
* File Capture
» TCP/IP Port Listening
* Print Capture
* Web Server
* Records Capture

Process
* Label Printing
e Database
¢ Web Service Client

Output
* Transfer Plug-in

Report
* Log File
e E-mail
* TCP/IP Port Listening

plug-ins list available in your application depends
on the product used.
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Input plug-ins

You have five input plug-ins at your disposal:
* File Capture
* TCP/IP Port Listening
* Print Capture
* Web Server
* Records Capture

File capture The File Capture plug-in collects files in a specific folder.

Files are processed in chronological order — the first file to
appear in the folder is the first file processed.

To be analyzed by the sentinel, the file must be
' accessible in read/write mode. In addition, the

. sentinel must have full control over the data file
before it will proceed with processing (the program
that is creating the data file for sentinel must be
finished writing the file).

From the Input tab of the Sentinel Properties dialog box,
select the Input plug-in and click Settings.

The following dialog box appears:
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“$File Capture Plug-in x|

Files path

Files names (wildcards 7 and * delimiter )

‘Watch method

& \Waitfor systemn events
© Check atfixed time intervals 0 ms

Digital signature

I~ Werify signature with certificate

I & E
Aftachment type
|1 024 bits key. beginning of file j

QK I Cancel | Help |

Figure 1 The Print Capture Plug-in window

Step 1 Type or select the file path of the folder to be
watched.

Step 2 Type file name or file extension of the files to be
captured.

You can type several files names separated by a semicolon
or use wildcard characters. Asterisk (*) is used to replace
zero or several characters. Question mark (?) is used to
replace one and only one character in a file name.

Examples
a*.txt Allfiles with extension .txt starting with
a (or A), like AF104.txt or a.txt.
item_n?.* All files named item_n + one
character, whatever the extension,
like item_n3.dat or ITEM_NZ.txt, but
not item_n24.doc
* txt;*.dat All files with extension txt and dat

Step 3 Choose your watch method:
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» Wait for file system events: In this mode, the
application is suspended until the system «awakens»
when a file is in the directory. At that time, the file
processing starts.

needed by the application. However, this method
cannot always be used. Some file systems, such
as shared folders on AS400, are not compatible
with the Windows notification system.

Q This method is a good way to limit the resources

¢ Check on time interval: The folder is watched at
regular intervals.

TCP/IP port This plug-in is viewed as a Socket server and receives data

listening from a client in a pre-defined format. For more information
about this format, please refer to the example available in
your installation directory. This plug-in can be considered
as an input and/or a report plug-in. It allows client
application to retrieve printing status. This plug-in can
support any kind of platforms.

From the Input tab of the sentinel properties dialog box,
select the input plug-in and click Settings.

The TCP/IP Plug-in window appears:
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4 TCP/IP Plug-in

B Connect network using

Font

|2550 :|

Maximum number
5

Connection string

]S I Cancel Helg

Figure 2 The TCP/IP Plug-in window
How does this the TCP/IP Plug-in work?
Step 1 The client tries to connect.
Step 2 The server validates the connection.
Step 3 The client sends a data process request.

Step 4 The server sends the events linked to the file
process.

Step 5 The server sends the end of process.

Step 6 The client disconnects or continues sending
information to the sentinel.

If this plug-in is considered as both an input and report
plug-in, events reported by the server to the client will
concern only the client that sent the input.
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General message A message is sent to exchange information between the
format client and the Socket Server. The structure of this message

is defined below.

Message size
(including those four
characters)

4 characters (long)

Command number

4 characters (long)

Parameter 1

4 characters (long)

Parameter 2

4 characters (long)

Job name 260 characters (char [260])
Data varying length
Data format Data sent will have the following format:

description

variable name = CRLF value

The variable name is the name of a variable on your label or

that of a control variable:

@LABEL_NAME: Used to indicate the label name to

be printed.

@PRINTER_NAME: Used to indicate the target

printer.

@LABEL_QUANTITY: Used to indicate the number of

labels to be printed.

If you want to send several process demands during the
same information exchange, data blocks must be separated
by CRLF (ASCII characters 10 and 13).

If there are several blocks of data, blocks are separated by

CRLF:

variable name 1 = value CRLF



Plug-ins

Appendix A - 57

Messages list

variable name 2 = value CRLF

variable name 3 = value CRLF

CRLF

variable name 1 = value CRLF

variable name 2 = value CRLF

variable name 3 = value CRLF

variable name 4 = value CRLF

Connection demand

The connection string indicated in the plug-in configuration
is aimed at allowing the client to connect to the server.

Command number

0

Parameter 1

0 (message with Ansi
characters)

1 (message with Unicode
characters)

Parameter 2

Client ID. Optional parameter
used to check information sent
from the server to the client.

Name Not used.
Data Connection string.
Job demand

Command number

2

Parameter 1

0 (message with Ansi
characters)

1 (message with UNICODE
characters)




Appendix A - 58

Administrator’s Guide

Parameter 2 Not used.
Name Job name.
Data Data to process.

Answer to connection demand

Once the connection demand has been made, the client

must wait for an answer from the server in order to continue.

Job name Client ID.
Command number 1
Parameter 1 0 (OK)

1 (false connection string)

2 (maximum number of clients
reached)

Parameter 2 Not used.

Name Not used.

Data Not used.
Answer to job demand

Command number 3

Parameter 1 0 (OK)

1 (cancelled)

2 (message)

3 (error)

4 (end of process)

Parameter 2

See table below.

Name

IP address or client's PC name
+ client ID (value set during
connection).
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Server
disconnection

Data

Text message linked to the
receiving of an error or a
message. The module name or
the name of the plug-in is
defined before this message.

Details about parameter 2

On message
reception and
according to what has
been selected in the
Report plug-in.

0 (Sentinel stopped: client
disconnected)

1 (Data received)

2 (Data to be processed)

3 (Data are sent to the output
plug-in)

4 (Free message)

On error reception

3 (Format not supported)

4 (Process error)

On end of process

Equal to the NewData return
value.

0 (OK)

1 Process canceled.

6 Process error.

7 Output plug-in error.

Communication between the client and the server can either
be done in UNICODE or in ANSI. If client data is sent in
UNICODE, the server will answer in UNICODE. It is the

same process for ANSI.

The client will be disconnected:

« For the input, if the client tries to send a new process
without having received the end of the process of the

previous demand.
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Print capture

* For the report plug-in only, if the client tries to send
data.

This plug-in captures spooled tasks on a printer. This
printer is set up during your plug-in configuration. All printed
tasks printed from your system to the printer will be
analyzed by the sentinel once activated.

Printing your document from a Windows application on a
sentinel printer may modify the original document. For
instance empty lines can be removed and tabulation
characters can be replaced by a carriage return line feed
sequence. In order for the map to read the reformatted data
correctly, do the following:

Step 1 Start by making the sentinel printer available for
printing, as it is suspended for the capture by default.

Step 2 Select the FILE port for the output.

Step 3 Print your document on this printer from your
application.

At print time, a dialog box is displayed that lets you
specify the output file name.

Step 4 Use the file that is printed as the work file to
define the Map file.

This method allows for the modifications that could
occur during the printing process.

Step 5 When the map file is done, don't forget to set
the printer back to suspended mode and to select the
COM1: as the output port.

original document is not modified through the use
of the driver. In that case it is possible to create
the map file with the original document.

Q When printing through the TCP/IP protocol, the
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Web Server

From the Input tab of the sentinel properties dialog box,
select the input plug-in and click Settings.

The Print Capture Plug-in window appears:

-ﬁLPrint Capture Plug-in

Select printer spool for input

Add new printer

Adld

O I Cancel | Help |

Figure 3 Print Capture Plug-in window
Step 6 Select printer spool for input.

Step 7 If you want to add another printer, enter its
name and click Add. The new printer appears in the
printer spool for input list.

Step 8 Click OK to validate.

Depending on the product version you have purchased,
this plug-in may not be available.

The Web Server plug-in allows the sentinels server to
receive information from a Web page, previously created
and configured for data collection. It allows the sentinels
server to be connected to any Web Application with a
minimum of integration work on the Web Application itself.
All'it would take is for a Submit button on a Web page to be
connected to the server’'s URL. This would send all the
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information entered in the Web page to be collected and, for
example, inserted into a database or transmitted to a Web
service available on the ERP system to perform a particular
transaction. Since this plug-in acts as an HTTP server, it will
answer an HTTP POST message and will call the assigned
process plug-in to act according to the information. The web
form will need to be customized to link the data collected on
the web page with the information requested by the process
plug-ins used by the sentinel.

[ Port configuration 9 [] 3

IP Address Used
IU 72.21.761.19) Intel(R) PRO000 MT Metwork Connection j

‘Webh Senver Port IBDBD 3:
Ok | Cancel | Help |

Figure 4 Port Configuration window

In order to customize a Web form, three things must be
done:

Step 1 Create standard input fields, giving them the
name of the variables you want to address from the
fields.

Example:

<input type= “edit” name= “variable_name” value=
“variable_value™>

For more details, please see the HTML sample web
form in the sample program directory.

Step 2 Create three input fields named Group,
Sentinel and Job Name that are used to identify the
sentinel which will receive the data and to provide a
name for the job.
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Example:

<INPUT type= “edit” name= “Group” value= “Production”>
<INPUT type= “edit” name= “Sentinel” value="S01">
<INPUT type="“edit’ name “JobName” value="Job2545">

Data will be processed by the sentinel “S01” of the
"Production group”. The Job will be referred to as
“Job2545”.

Step 3 Customize the method and action parameters
for the form so that it could be linked to the sentinels
server.

Example:

<form method= “post” action=
“http://sentinel_server:port_number/des”>

</form>

Each input field name and value will be sent to the sentinel.
Then, the sentinel will tell the caller (usually the Web
browser) to call back to the web server’s normal address. It
allows the data to pass through the sentinel, first, and then
again through the web application is it has been designed
on a web server such as IIS or Apache.

Another way to exchange information between your
application and the sentinels server through the web server
plug-in is to directly use the web service that is published.
From a development platform that supports web service
calls, like .NET or J2EE, you can directly invoke the
function exposed by the web service. To do that, you
simply need to provide the URL address of the plug-in web
service:
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Records
capture

http://sentinel_server:portnumber/service?wsd|

Your development tool should create a wrapper containing
two methods and an enumeration (function result):

Process1 (

Group as string : name of the sentinel group
Sentinel as string : name of the sentinel
JobName as string : job name to be displayed

Values as ArrayOfString : array of strings
) as FunctionResult

array of string example: array( “Name”, “McCarthy”,

“Surname”, “Doris”)

Process2(

Group as string : name of the sentinel group
Sentinel as string : name of the sentinel
JobName as string  : job name to be displayed
Values as string : string representation of values

) as FunctionResult

Values: “Name=McCarthy\r\nSurname=Doris\r\n” where
“\r\n” represents CrLf (Carriage return, Line feed).

FunctionResult enumeration:
OK : process has been done successfully

Canceled : process has been cancelled
Err_Process : process raised an error

Principle

The plug-in watches the output of an SQL query and detects
new records based on different user selectable strategies.

For each new record, it sends a process request to the
sentinel.

Depending on the selected strategy, it writes status
information in each processed record, deletes the
processed records or just counts the number of records.

Sentinels using this plug-in do not need a map.
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User interface

Plug-in settings

Data Source

Nane Connect 50l fade

Teble and fields
Table | |
Fisld { Alias | jI@LAEEL_NAME =
| l[EPANTER NAME +]
[ ~|[@LaBEL auaRTITY <]

Dt sample

—Detaction method far fows 1o pracess

Methoot:[Read & wiite process stalus in = dedicaled field

El
Unicue iclentifier figld | j

Progess stels field [

The dialog box for the plug-in is composed of a single
Window with four sections:

« Data source

« Table and fields

+ Data sample

* New rows detection method

The window is resizable to some extent.

Expansion mainly allows viewing more columns and rows
from the Data Sample section.

Size is automatically saved and restored between sessions.
Data source

First step is to select a data source. Click the Connect
button to open the standard Windows OLEDB database

connection dialog.

As soon as the data source is defined, the dialog box will
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update to list all the retrieved tables.

The option box labeled "SQL Mode" is also enabled. This
mode is described in the SQL Mode section below.

Here are some common connection settings for known
database types.

SQL Server, OLE DB provider mode:

-1st tab: select Microsoft OLE DB Provider for SQL
Server

-2nd tab: item (1), specify the name of the machine
where the SQL server resides

* item (2), enter user name and password (check the
"record password" option box)

« item (3), select a Catalog from the drop-down list

Oracle, OLE DB provider mode:
-1st tab: select Microsoft OLE DB Provider for Oracle

-2nd tab: item (1), specify the published name of the
Oracle server

* item (2), enter user name and password (check the
"record password" option box)

Access (MDB):

-1st tab: select Microsoft Jet 4.0 OLE DB Provider (or
latest version if available)

-2nd tab: item (1), specify the data source as the path to
the .MDB file
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Excel (XLS):

-1st tab: select Microsoft Jet 4.0 OLE DB Provider (or
latest version if available)

-2nd tab: item (1), specify the data source as the path to
the .XLS file (*)

-4th tab: double click 'Extended properties' and enter
Excel 8.0

Dbase (DBF):

-1st tab: select Microsoft Jet 4.0 OLE DB Provider (or
latest version if available)

-2nd tab: item (1), specify the data source as the path to
the folder containing all the .dbf files (*)

-4th tab: double click 'Extended properties' and enter
DBase 5.0

Delimited text files (CSV):

-1st tab: select Microsoft Jet 4.0 OLE DB Provider (or
latest version if available)

-2nd tab: item (1), specify the data source as the path to
the folder containing all the .CSV files (*)

-4th tab: double click 'Extended properties' and enter
Text;Hdr=Yes;Fmt=Delimited (**)

(*) The "..." commands only allows selecting a file name

whereas a folder is needed. To override this behavior,: in the
"..." dialog select the file filter "Any file" and select any file
from the intended folder and validate. Back from the dialog,
manually edit the data source path to remove the file name,
only leaving the folder name like for example c:\mybases\.
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(**) For Unicode text files, enter
Text;Hdr=Yes;Fmt=Delimited;CharacterSet=Unicode

| Note |

For other variations (no header, other delimiter char than
semi-colon ...etc) you should use a schema.ini file as
explained here: http://msdn.microsoft.com/en-us/library/
ms709353.aspx

Table and fields

Once the data source is defined, the table list shows all
retrieved table names.

Select the table from which the plug-in should pick records.

The Data sample will display the first available rows from the
table (up to 10).

You can resize the window if you want to display
Q more rows or columns.

The table selection can be automated if the table contains a
table or a view having a name starting with SENT_.

(For more information see the Automated Configuration
section.)

Field / Alias

If the field names from the table do not match the variable
names (or control variable names) from the process plug-in,
you can create up to three relations there. Known control
variables are listed. For variables not listed, just type their
name here.
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Example:

Data Source

’7C\Cupwe de identity mdkb Edit I” SQL Mode

~Table and fields

RSB [DENTITY] -
Field / Alias | =l |@LAEEL_NAME |

| -] [@PRINTER NAME -]
| ~l[ersBEL_auanmmy -]

—Data sample

[ Label | Frinter | FIRSTNAME | NAME | ADDRESS | oY | §TAT =
identity.lab Zelra 170Xi4 Doris Samuelson Bull Run Ranch Aurara co
cartonlab  DatamaxH4212  Craig McDougal 1 Airpont Drive Chicago L
paletelab ToshibaBSX4  Roxie Aberdeen 15 State Street Dallas ™
identity.lak IntermecPF4i  John Mason 2421 Prospect Ave Berkeley CA
identity.lab Sato Gz408e Warren Cole 3434Washington Bled. Indianapolis 1N
sscclab  CabXC4 Med O'Hare 4960 Fullman Ave, NE  Seattle WA
identity.lak Smartdated Emerson  Yee 2936 4Znd Street Mew Yark MY
:Tmn Inh_ Zabra 110 PAXA lack Andarsnn 8847 San Andrans Klamath IFF\\I-: nRﬂ;‘

—Detection method for rows to process

Method - Piemdl & wite process status in & dedicated field

|
Uniue idenifer field :[ E

Process status field :|

Help Ok Cancel

- The column giving the name of the label to print spells
"Template' in the table: select field TEMPLATE and alias
@LABEL_NAME.

- The data from the column FIRST should go in the label

variable FIRSTNAME: select field FIRST and type alias
FIRSTNAME.

If you need to create more than three aliases, you will have
to switch to SQL mode and type the query containing the
needed AS clauses.

For instance:

SELECT Template AS @LABEL_NAME, FIRST AS
FIRSTNAME ...etc... from JOBS

(For more information see the SQL Mode section.)
Detection of records to process

The plug-in offers a choice of three detection strategies:

-Read and write process status in a dedicated field, or
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-Process and delete each row, or
-Count rows.

If migrating from LABELVIEW data watch, the last method is
convenient for DBF files.

The first method should be used if possible on all other
database types.

Status

For this strategy, the plug-in uses a dedicated field from the
table to act as a status field. The plug-in processes each row
without status. Then it writes back the process result as
status value.

- The field type must be numerical.

[ Note |

In Excel sheets, default data format is string, not numerical.
To define the "Status" column as numerical, change the cell
format to plain number (without decimal).

- The field must be set by your system to NULL or zero
in records to process.

- At the beginning of the processing, the plug-in writes
the value 1 in the field; after processing, it writes either 2
for success or 3 for failure.

- Any value (except NULL, O, 1) can be set in a new
record to postpone its processing. Value can be set to
NULL or zero at a later time to release the record for
normal processing.

This strategy requires also a unique identifier field to
distinguish records and to allow selecting/updating records
one by one.

[ Note |
In the snapshot below, the identifier UID does not belong to
the table. It is made up on the fly in the SQL query by
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combining the three fields First, Name and Zip.

Plug-in settings L

Data Source

’7C\Cup\e de identity mdb Edit ¥ 50L Mode Execute

~Query definition

[SELECT * (Firsthame + + Name + '+ Zip] 45 LID FROM [IDENTITY] =]

<]
~Datasample

‘ uio | Label | Prirter | FIRSTHAME | MAME | ADDRESS =

Dorig Samuelson 83022 identitylab Zebra 170xi4 Daoris Samuelson Bull Run Ranch

Craig McDougal 60542 cartonlab  Datamax H4212  Craig McDougal 1 Airpart Drive

Roxie Aberdeen 76043 palette |lab Toshiba BS*4  Roxie Aberdeen 15 State Sfreet

John Mason 34704 identity lab  Intermec PF4i John Masan 2421 Praspect Ave

‘Warren Cole 46241 identity |lab Sato Gz408e Warren Cole 3434Washington B

Med O'Hare 98105 ssoclah Cab X4 MNed O'Hare 4350 Pullman Ave. |

EmersonYee 10032 identitylab Smartdate’ Emerson  Yee 2938 42nd Street

J?EkAndersnn 87603 cartonlab  Zebra 110 PAXA Jack AndFI,-rsnn 6947 San Andreei,ﬂ

‘ »

—Detection method for raws o process

Method [ Fiead & wite process status in a dedicated field

Unigue identifier field :|U\D

Frocess status field :[STATE

Lol Led e L]

Table of the status field :[[DENTITY]

Help Ok Cancel

To help you decide if this strategy is well suited for your
system, here is a summary of pros and cons:

Pro:

-You can check the table to know which records
succeeded or failed,

-You can reset the status to have some records
processed again

-You can delete records that are not needed anymore
Con:

-The table structure may need modification to add the
column acting as Status (*),

-The sentinel will be writing in the table after each
process, so the database must support multiple access
(your system will be adding rows while the sentinel writes
the status in processed rows)
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(*) Tip: By using SQL mode, you can store the status in an
independent table joining the main table through a unique
key. This avoids modifying the main data table.

Process and delete all rows

Each record is processed then deleted.

This strategy requires a unique identifier field (a field which
value cannot appear twice through the table) to distinguish

rows and allow deleting rows one by one.

When selecting this strategy, select also the field to use as
unique identifier. It can be:

- A built-in counter managed by the database system (also
called AUTO INCREMENT),

- A unique data managed by your data model, like a serial
number, a driver license ID, an email address...etc

Pro:

-Any table can be monitored without change to its
structure.

Con:

-Processed records are deleted, so the table is
somewhat dedicated to the processing done by the
sentinels server

-The sentinel will be updating the table after each
process, so the database must support multiple access
(your system will be adding rows while the sentinel reads
and deletes other rows)

Count rows

The plug-in counts the number of records returned by the
query. When the number has increased since the last
counting, the plug-in knows how many new records were

added to the table.

This method is quite straightforward but has some major
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drawback: new records are easily located in sequential
databases (DBF, CSV and XLS) because they are
guaranteed to appear at the last positions.

This natural order is not guaranteed for transactional
databases. Records may be re-ordered as the result of
optimization, indexing, backup restoration ...etc. For
transactional databases, you should favor the "Status"
strategy.

Pro:

-Any table can be monitored without change to its
structure.

-No writing is made by the plug-in (no shared access
problem)

Con:
-The plug-in would miss some new records if an external
process (or user) deletes some older records. So record
deletion is forbidden during sentinels' activity.
-New records can only be detected if they are added
while the sentinel is running. (So before adding new

records, ensure the sentinel is active.)

-If the sentinel reports some process error, there is no
easy way to know which records were involved.

Query definition in SQL Mode

The SQL mode is required to create advanced queries
(select on multiple table, conditions...etc.).

When you check the SQL Mode option the second section
becomes "Query definition" and a button labeled Execute is
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displayed:

Plug-in settings T

Data Source
( CiCopie de identity.mdb Edit.. FI§QL Made Executs
Query definition
1 E
|

Input (or paste) your query and select the Execute button
located to the right of the SQL mode switch:

Plug-in settings:

Data Source

’70\00;:\5 de identit.mdb Edit.. ¥ S0LMade Execute

—Query definition
SELECT ", (FirstMame + "' + Name + ' '+ Zip) AS UID FROM [IDENTITY] d

|
—Data sample

| u | Label | Printer | FIRSTNAME | NAME | ADDRESS -
Daoris Samuelson 83022 identity lab Zebra 170Xi4 Daris Samuelson Bull Run Ranch
Craig McDougal 60542 cartonlab  DatamaxH4212  Craig McDougal 1 Airport Drive
Roxie Aberdeen 75043 palette lab ToshibaBSx4  Roxie Aberdeen 15 State Street
John Masan 84704 identity |ah  Intermec PF4i John Mason 2421 Prospect Ave
Warren Cale 46241 icentity.lab Sato Gz408e ‘Warren Cale 3434 Washingtan B
MNed O'Hare 98106 sscolab  CabXC4 Med O'Hare 4950 Pullman Ave. [
Emerson Yee 10032 identity.lah Smartdates Emerson  Yee 2938 42nd Strest
Jim:k Anderson 87603 cartonlah  Zebra 110 PAXd Jack Andelrsun 8947 San Andreai'LI
4 »

~Detection method for rows to process

Method [P & wite process stetus in & dedicated field

Unicue identfier field :[ID

Process status field : [STATE

[ER (KRN (KN

Tahle ofthe status field I[IDENT\TY]

Help Ok Cancel

If the query syntax was wrong, the error message coming
from the database engine would display in the Data Sample
area.

New records detection strategy and SQL mode

The field list appearing for the detection method "Delete"
and "Status" are editable. If the sentinel reports syntax
errors for the query, check that the selected field names are
unambiguous and edit them accordingly.

In the example above, the field COUNT doubles some SQL
keyword so if it were used, it should be enclosed in square
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braces as in [COUNT].
Automated configuration

If certain conditions are met, the plug-in configuration can be
set automatically.

Conditions are:

-The database contains a table with a name starting with
SENT_.

-The table contains two fields named SENT_STATE and
SENT _ID to be used as Status field and unique ID field.

For example, under SQL Server, use SQL Management
Studio to create a view named SENT_PRINT.

Arrange the view to gather all the required data. Have two
columns named SENT_STATE and SENT _ID.

Now in the plug-in, select your database as the data source.
The plug-in will find the table and propose to use it. If you
agree, it will then select the two columns for the "Status"
detection strategy.

Multi field

(Feature not appearing on the previous user interfaces)

In some situation it is convenient to bundle several pieces of
data in a single field, especially when the label template
could change at each record and its variables are not known

at this time.

For this type of column containing a series of named values,
the section Multi field allows to define its format:

- Field : the field name.

- Separator : the character (or string) delimiting two adjacent
pieces of data.

- Assignment sign : the character (or string) delimiting the
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name from the value.

Example :

Having a column named DynList that contains a piece of
data like "Hei.:22/Wid.:40/Dep.:60/Col.:Stone" the
configuration should be:

- Field DynList

- Separator /

- Assignment sign .

For this record, the selected process plug-in will have at its
disposal the four variables Hei, Wid, Dep, Col .
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Process plug-ins

Three process plug-ins are available:
* Label Printing
» Database
* Web Service Client

Process plug-ins are used to determine the way in which
your information will be processed. Process plug-ins
manage variable collections to perform the work they have
been designed for. There are two types of variable:

Standard:
* The Label Printing plug-in manages variables defined
in a label created with the label designer.
» The Database plug-in manages variables associated
with a task that is defined with the Query Manager.
* The Web Service Client plug-in manages variables
associated with the parameters of a web service
function.

Control: These are the variables that can influence the
processing work of the plug-ins.
* The Label Printing plug-in uses the @LABEL_NAME
variable to define the label to print, the
@PRINTER_NAME to select the target printer or the
@JOB_NAME to specify a name to the data stream
received by the input plug-in.

Here is a list of control variables. Some may not be available
with your installation.

@ LABEL_NAME

Label Printing Define the label to print. The
name of the label can be the
label’s name on disk or the
complete path and name of the
label. ex: @:\Desktop\
my_archivingsystem\
my_labeldesigner\ Mylabel.lab

@PRINTER_NAME

Label Printing | Select the target printer.
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@OFFSETX and Label Printing Modify the location of the printing
@OFFSETY on the paper. The values allowed
are between -32769 to 32769 in
tenths of a millimeter. These
control variables may not be
available with all installations.

@DEFAULT_PRINTER Label Printing | Name of the printer to use by
default when the
@PRINTER_NAME control
variable is not defined.

@DEFAULT_LABEL Label Printing Name of the printer to use by
default when the
@LABEL_NAME control
variable is not defined.

@LABEL_QUANTITY Label Printing Name defined in this control
variable will set the number of
labels to be printed.

@DEFAULT_QUANTITY Label Printing Name of labels to print when the
@LABEL_QUANTITY variable is
not defined.

@LABEL_COPY Label Printing | Defines the number of labels to
copy — may not be available with
your installation.

@PAGE_COPY Label Printing Defines the number of pages to
copy — may not be available with
your installation.

@INTERCUT Label Printing | Defines the number of labels to
print between each page cut —
may not be available with your

installation.
@TASK Database Select the task to execute.
@WEBMETHOD Web Client Select the web service method to

Service execute.
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@JOB_NAME Global Gives a name to the transaction
or group of transactions
executed by the process plug-in.
If the variable is not explicitly
assigned, the file name will be
used as the job name. This
information is used for the
archiving system’s print history
log to help you to quickly find and
retrieve a print job.

Label Printing This plug-in prints barcode label with data found by the
mapper.

From the Process tab of the sentinel properties dialog box,
select the process plug-in and click on Settings.

The Printer Selection window appears:

. Printers :

Defaultvalues | Options

Add / remove .
Show selected items only ™
| | Aliases | /. Printer Port |
O & Zebra R402 >COMT:

License for 3 printers, 0 selected

OK. Cancel Help

Figure 5 Printer Selection window
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@

Step 1 From the Printers tab, select the printer(s) you
want to use.

You can define aliases for each printer. For example if
you define "Production1" as an alias for the printer
"Plasmatronic TH640, \\ServerProduction1", the
sentinel will select this printer if the data analysis found
the data Production1 as the printer name to use for
printing.

If the printer is exchanged for a different model, you
will just have to assign the alias to the new printer in
the plug-in configuration. No modification will need to
be done on the data.

The alias is used prior to the real name of the
printer. For example, if you want to redirect the
printing demands from the "Plasmatronic TH640"
to the "Matrix Code IV", you simply need to assign
the alias "Plasmatronic TH640" to the "Matrix
Code IV" printer.

Step 2 On the Default values tab, type or select a file
to be printed.

Remember that first priority is given to the control
variables found in the file, then to the default value
such as this one.

| Note |

By default, in step 2, if a label is selected from the label
archive system, the selected value does not include the
version number. You can add this information manually
in the edit box as mentioned above.

Step 3 Select a default printer on which documents will
be printed if no printer is specified in your data file.

Step 4 Fill in, if needed, the number of labels to be
printed, the number of copies, etc.
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Database

Step 5 Activate the When opening a document,
clear its variables option if you want to erase the
variable values saved in the document when it is
opened. If not, the values saved in the document will
remain until new values are provided by the file
analysis.

Step 6 In the Options tab, configure the available
settings as per your needs. The list of available
settings will change according to the label designer
installed.

Step 7 If you have installed an archiving system, you
will have an additional tab called Archiving. Select the
Archiving tab in order to enter the user name and
password information necessary to access the
archiving system, to select the level of history tracking
information you would like to keep and the default
category from which your labels will be extracted.

The history tracking options are as follows:

* Track Printing: Allows reprinting

* Track Errors: Adds one record in case of an error

* Track Warnings: Adds one record in case of a warning
* Track other events: Adds one record for other activities
such as file opening and closing

Step 8 Click OK to validate.

The print management system will print the latest validated
label version if you don’t explicitly specify the label name
and version to print. If no validated version exists for the
label, then the print management system will print the latest
draft of the label (requires administrator or manager rights).

To specify a given archive version, the filename must be
suffixed with an underscore and the version number (for
example, identity.lab_3).

(Note |

To use the Database plug-in, you require an additional
license. Please contact your reseller to activate this
functionality and ensure your database system is
supported.
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The Database process plug-in allows a sentinel to execute
queries and call stored procedures over different database
systems with the information received from the input plug-
ins. Queries are defined at design time on the workstation
using the Query Manager application.

Once the queries have been created they can be
associated with stored procedures and called into a task.
Task and query definitions are saved into two configuration
files (task.xdb, database.xdb). These files must be used
from the sentinels server when defining sentinel tasks with
the information captured from the incoming data stream. It
is then possible to execute a set of queries combined with
stored procedure calls over different database systems for
each block of data found by the sentinel.

Task selection (O] ] |

Choose one task

1 Task_3100
Task_2457
] Task_505

Ok | Cancel | Help

Figure 6 Task Selection window
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would be called by the data stream received by a
sentinel, you must assign a value to the @TASK
control variable.

Q If you want to dynamically select the task which

Step 1 Select Database.
Step 2 Click Settings.

Step 3 Enter a Task Definition File or click Browse to
search for an existing file.

Step 4 Select one task from the list of configured tasks
and click OK.

This task will be called up by default by the sentinel if the
@TASK control variable is not set in the data stream.

Web Service The goal of the web service client is to send data through
Client WebService calls over the internet or intranet network.
[Hcall selection |
Choose one call
Ok I

Cancel

Add

Delete

Modlify

Help

Figure 7 Task Selection window
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Configuration To use web calls, you must first ask for the web service
description file (WSDL file).

Step 1 Open the WebService plug-in dialog box.
Step 2 Click the Add button.
The WebService Resolution window opens.

Step 3 Type the WSDL address (URL) in the edit box
and click on the green arrow.

The plug-in will look for the service description. If a
user login and password is required, a dialog box will
be opened to enter required values.

Methods are listed in the table by method name
followed by its parameters. Parameters are indented. If
you click on a line, corresponding documentation will
be shown on the bottom panel.

To add a method to the plug-in’s usable method list,
just enter an alias beside the method name. You can
also give an alias name to the parameter name. When
running sentinel, if parameters have an alias name,
this one will be used as the variable resolution. The
sentinel’s variable value will be sent to the
corresponding parameter. If the parameter alias is
omitted, its name will be used.

When methods are selected, you can close the
Service Resolution dialog box. Then, in the
configuration box, select the method to call from the
plug-in as long as the @WEBMETHOD control
variable of the plug-in is not set in the sentinel’'s
incoming data stream.
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Web Service Test

You can test a method through the Web Service Resolution
Dialog Box. Open this dialog box, then click the Test
button. A combo box allows you to select the method. Enter
the parameter values and click on call. If a result is sent
back, it will be displayed in the result panel.

Limitation During the sentinel process, the result from a web call
cannot be used or interpreted.
Output plug-ins

Transfer plug-in

The transfer plug-in transfers input data to a specific
directory according to the process result.

On the Output tab of the sentinel properties dialog box,
select the output plug-in and click Settings.

The Transfer Plug-in window appears:

‘,,' Transfer Plug-in

Folder for generated files

" Incase of success

[~ Incase of failure

Days to keep files

I 5 Days

0

Cancel Help

Figure 8 Transfer Plug-in window

In the Folder for generated files zone, select where you
want to save your file in case of failure or in case of
success.

In the Days to keep file zone, enter the number of days
that the files will be kept.
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The file name created by the output plug-in is
identical to the name of the data set that is
received by the input plug-in. If the same name is
used for two different data sets, the old transferred
file will be overwritten by the new one.

The Days to keep files option is only activated
when a sentinel sends a file to the Transfer plug-
in. If the plug-in is used, files remain in the transfer
folder the amount of time specified in the Days to
keep files option.

Report plug-ins

Log file

You have three Report plug-ins at your disposal:
* Log File
* E-mail
e TCP/IP Port Listening

The Log File plug-in logs sentinel events in a text file. On
the Report tab of the Sentinel Properties window, select
the report plug-in and click Settings.

The Log File Plug-in window appears:
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< Log File (=

File:
Path
fe

Max file size (1...10240) |1024 Kb

Contents
w| Expiring licence -
vl Process results (passfail)
v| Errors
Detailed events

Format: (check the online help for valid syntax) Restore

(date) (time) | (num) | (event) : (plug) [ (info)(crlf) -

Help Ok Cancel

Figure 9 Log File Plug-in window

Step 1 On the file zone, enter the file path. The
generated log file name is made as follows: REPORT
(<sentinel name>).txt.

Step 2 Check one or several options in the Contents.

Step 3 In the Format zone, change the syntax of the
file.
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E-mail

The E-mail plug-in sends an e-mail containing all of the
chosen events.

On the Report tab of the Sentinel Properties dialog box,
select the input plug-in and click Settings.

The E-mail Plug-in window appears:

<5 Email report (=)

SMTP server: ||smtp.provider.com
Port: |25
Use authentication : || ¥
Useraccount: ||123456
Password : ||
Use SSL: ||
From : ||sentinel@provider.com

On start or stop : 1

On error : ||it@provider.com; prod@provider.cc|
Onwarning : 1

On licence expiry : (|it@provider.com q
Help Test Ok Cancel

Figure 10 E-mail Plug-in window

Step 1 In the SMTP Server zone, enter your SMTP
Server address and select your port.

The SMTP port number is commonly set to 25.

Step 2 Check the Authenticate box if your server
requires authentication and enter a user account and
password. Check the Use SSL box if your SMTP
server requires secure socket protocol.

Step 3 In the From zone, enter the address of the
sender.
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TCPI/IP port
listening

Step 4 In the four Recipient zones, enter the e-mail
address of the person you want to contact when the
corresponding event occurs.

If you want to add several addresses for the same
events, separate them by a semicolon (;).

Click the g button to access to the Message format

window.

Once you have entered your parameters, you can click
Cancel or Test if you want to check the parameters you
entered. Then the plug-in tries to send an e-mail to all of the
specified recipients. The e-mail sent uses the same format
as the one specified in the settings of the plug-in so that
you can check it.

The TCP/IP Port Listening plug-in is viewed as a Socket
server and receives data from client in a pre-defined
format. For more information about this format, please refer
to the example available on the DVD. This plug-in can be
considered as an input and/or report plug-in. This plug-in
can support any kind of platforms. For more information
about this plug-in configuration, please refer to the Input
plug-in section of this chapter.

¥ TCP/IP Plug-in x|

Connect netwark using

Fart Clients Connection string
o 4 F 3 |
Contents

O Pracess results (pass/fail)
Errars
O Detailed events

OK I Cancel Help

Figure 11 TCP/IP Plug-in window
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